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1968 vs. 2018

We have to deal with complexity by hierarchically ordering
function and variability

(E.W. Dijkstra: NATO Software Engineering Conference, 1968)

We have to understand how to design and implement reliable
software such that maintenance, changeability, and
variability are easier to handle. [...]

Software engineering is part of systems engineering of
cyber-physical systems closely connected to the real world.

(M. Broy: IEEE Software, 2018)
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Cyber-Physical Systems I’'ve worked SIEMEN
with (just a selection)... () pRiMETALS

Continuous Casting Machines Electric Arc Furnaces
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Key Challenge of working with CPS:

Multidisciplinarity

(c) G. Renee Guzlas, artist

Rick Rabiser — rick.rabiser@ijku.at
https://rickrabiser.qithub.io/rick/

J XU o technotooy

Commu-
nication

Cross-cutting issue:
systematically dealing
with variability!

(c) Alois Zoitl
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Variability and Multidisciplinarity in Practice

Oct 4/5, 2021: Facebook, Instagram, WhatsApp Down for SRS

This is a global outage for all FB-related services/infra

Several hou rs (7h+) World_Wlde (source: I'm currently on the recovery/investigation team).

Facebook Stocks down by more than 5 percent, over 40
Billion US Dollars

Reason? Software configuration error with effects on
As many of you know, DNS for FB services has been

FOU'[I ng ' affected and this is likely a symptom of the actual issue,
and that's that BGP peering with Facebook peering routers

LY
Update 1440 UTC:

* Why so long to fix problem? R s e
. (started roughly 1540 UTC).
o People with knowledge about routers are not the same R

. . There are people now trying to gain access to the peering

people with knowledge how to fix the software routers o implement fixes, but he people it physica

. . access is separate from the people with knowledge o

how to actually authenticate to the systems and people

Conflg u ratlon prObIem who lt<nowtwhe¥t totacn}a//ytdct, sto theyretis now a I%gistical

challenge with getting all that knowledge unified.

Part of this is also due to lower staffing in data centers due
to pandemic measures.

https://en.wikipedia.org/wiki/2021 Facebook outage
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Industry and Variability

“Industrial reality

“CRENLs v | Shows the number !
gb;T%SLif“HB of variation points, . Globalization
VARIABILITY | Vvariants, and
e - | dependencies
= easily reaches Product
staggering levels Varient

[.. ] often resulting in a situation in
WhICh nO One [] has a Source: Yoram Koren, The
comprehensive overview of the | Brodict Versky Sy
available variability.”

Jan Bosch, Raffael Capilla, Rich Hilliard: Trends in Systems and Software Variability. IEEE Software, vol. 32(3), pp. 44-51, 2015.
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Variability?

‘the ability of a system or
artifact to be efficiently
extended, changed,

customized or configured for
use in a particular context”

(Capilla et al. 2013)

Baseline 1 Baseline 2 Baseline 3 Baselined ... BaselineM httpd -ngf -~ Win32 Apache

KeopAliveTimsout 13

(c) Charles Krueger, BigLever
J ! U LINZ INSTITUTE Rick Rabiser — rick.rabiser@jku.at SECPS: A Story of Variability and
OF TECHNOLOGY https://rickrabiser.github.io/rick/

Complexity


mailto:rick.rabiser@jku.at
https://rickrabiser.github.io/rick/

SECPPS (Software Engineering in
Cyber-Physical Production Systems) and Variability

* Goal: address the challenges in adopting state-of-the-art SE tools and techniques in the
production automation domain and discuss various approaches to tackle the issues

* Founded by: Rick Rabiser, Birgit Vogel-Heuser (TU Munich), Manuel Wimmer (WIN/SE, JKU),
Andreas Wortmann (Uni Stuttgart), Alois Zoitl (JKU)

Language @GS Sem Nam Sty Lib Pat A T D
Multidisciplinarity Variabilit S S
ariability SysMLvi6 @« & & = @ a (O a @
MontiArc e o o = [ ] c & @ [ ]
IVML ® o O O @ @ @ @ e
PPRDSL ® ® @ O ] O e @ =)
SECPPS Sl e DSL Ecosystem Maturity Model
C h al I e n g eS Req u i rements Documentation Tools Analysis Patterns design patterns, syntactic constructs, behavioral patterns
) parser _ Library
| mg(.a”gzodne;;‘gzn ‘;C)rlr-gfi:g:‘a(;reﬁri‘:{ violated we\\s-y;r(:;dness rules in:r;z:emzﬂlnr::;s
£ rct:1e rl’\p\e editor (syntax highlighting) semantics dependency management
active forums auﬁ,;gﬁffﬁﬁ,‘:ﬁng code guality Style Guides Naming Conven tions Semantic
. Knowled ge Data An a|ytICS spet‘:mc‘a.lion explicit, implicit semar;?ic domain
Educatlon Managment & AI F inform: \deﬂr’:i’(:iog
Grammar and Syntax abstract syntax, concrete syntax, well-formedness rules
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Earlier Research: My Journey of Developing a
Configuration Tool 2006-2013

ASE 2012

CW Usab
Study

- Flexible Variability
Modeling Approach

- Derivation Model

- Config. Prototype

- Model Fragments
- Evolution Support
- Case Studies

- Multi Product Lines
- Product Line Bundles
- Distributed Configuration

Project Role Advanced Help

(2) Decisions (Simelt_prefilled_new.gen)

| AC/NEC Integration | 2] HMI| J2] Basic system | J£ MDC/NEC/FSM Options

Project Information

& Spare Parts | | Customer Details | J=| ROI Requirements | =] Commercial Conditions,

Research Results from Christian Doppler Lab ASE

]
£ o iy == ==

Perspective

SIEMENS
VAIZ

=0

- Sales Support Workflow
- Focus on End Users
- Deployment Support

Break Even after

19 months

:<#Which power supply from plant side? 115V

«# Power supply backup via UPS from plant side? yes

(@ Provision of UPS (Rack design) mounted inside the

€ Calculated Values € Price List =g Documen ts 33 e

Benefit Value Unit * || Documen 13 Path xipledas =

Annual production output 3194901 tons ) Simett_PriceList.doc CADQPLER)J e Sy

Tap to tap time 609 minutes ) Simett_Variability.doc CADOPLER\| =

Saved tap to tap time 41 minutes 8] Simelt_CustomerInformation.dac C:\DOPLER\,

Saved electric current 1437706 EUR

Saved electrode consumption 989141 EUR s
Additional heats per day 15 oo
Additional annual output 194901 tons S—
Additional annual profits 389.8029 EUR N
Total benefits 6324876 EUR

2006

2007

2008

Refactoring & Maturation Project

(=

= — - Conf. Tool for Generating
Documentation / Business
Calculations / etc.

Industrial Rollout at SVAI

SECPS: A Story of iariability and ‘ ‘
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Recent Research: V4ardiac: Multidisciplinary

SPLC 2023
Ind. Challenges

Delta-Oriented Variability Management in CPPS

a4

Expressing variability
from different aspects
(e.g., business, signal,
process) using
heterogeneus
variability models

AR X

Cance

Product configuration
interface based on
variability models

J XU o technotooy

Rick Rabiser — rick.rabiser@ijku.at
https://rickrabiser.qithub.io/rick/

delta DApplyCapPresNotReached:
uses Application;

{

<Modify > Subapplicatior
<Add> EventOutput Error

<Add> EventConnectior
PnP_Pressure Sens_3 .REQ;

<Add> EventConnectior
PnP_Pressure Sens_2 .REQ;

<Remove> EventConnectio
PnP_Pressure Sens_2 .REQ;

1 PnP_ApplyCap {
type=Event;
<Add> FB PnP_Pressure Sens_3 type=3SkillFB;

n PnP_C5_1.CNF

n PnP_PressureSe

n PnP_C5_1.CNF

ns_3 .CNF

Express control
software variability
using delta
models
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SECPS: A Story of Variability and
Complexity

Control software
generator based on
selected configuration
options
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Recent Research:
Universal Variability Language (UVL)

* A community effort towards a

unified language for features

variability models Sandwich

o https://universal-variability- mandatory Sandwich

language.qgithub.io/ Bread
optional
Sauce Bread | Sauce @ Cheese

* UVL is a direct result of the ELATETEEE /O\

efforts within the initiative Ezzz e

o https://modevar.qithub.io/ hoaea

constraints

. : Ketchup => Ch
* Want to try it? https://uvl.uni- SHeilp = Hheese

ulm.de/
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UVL Support

* Language Levels (Boolean, Arithmetic, Type, ...) ]
* Multi modeling concept (via imports) Dok

* UVL Tool Support
° (ANTLR) Parser Implementations for Python and Java IDE
° Integrated in FeaturelDE and FLAMA and TRAVART
° Importers/exporters for other tools, e.g., pure::variants
° Rust-based Language Server Protocol for integrating UVL
iIn any IDE: UVLS

° Web-based playground based on UVLS UVL Playground
° Visual Studio Code extension based on UVLS

* Examples: https://github.com/Universal-Variability-Language/uvl-models

J z U LINZ INSTITUTE Rick Rabiser — rick.rabiser@iku.at SECPS: A Story of Variability and
OF TECHNOLOGY  https://rickrabiser.qgithub.io/rick/ Complexity
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UVL Publications

* Chico Sundermann, Kevin Feichtinger, Dominik Engelhardt, Rick Rabiser, and Thomas Thim. 2021. Yet another textual variability
language? a community effort towards a unified language. SPLC ‘21. https://doi.org/10.1145/3461001.3471145

* Chico Sundermann, Stefan Vill, Thomas Thim, Kevin Feichtinger, Prankur Agarwal, Rick Rabiser, José A. Galindo, and David
Benavides. 2023. UVLParser: Extending UVL with Language Levels and Conversion Strategies. SPLC ‘23 - Tool Track.
https://doi.org/10.1145/3579028.3609013

* Chico Sundermann, Tobias Hel3, Dominik Engelhardt, Rahel Arens, Johannes Herschel, Kevin Jedelhauser, Benedikt Jutz, Sebastian
Krieter, and Ina Schaefer. 2021. Integration of UVL in FeaturelDE. MODEVAR@SPLC ‘21. https://doi.org/10.1145/3461002.3473940

* Kevin Feichtinger, Johann St6bich, Dario Romano, and Rick Rabiser. 2021. TRAVART: An Approach for Transforming Variability Models.
VaMoS ‘21. https://doi.org/10.1145/3442391.3442400

* Dario Romano, Kevin Feichtinger, Danilo Beuche, Uwe Ryssel, and Rick Rabiser. 2022. Bridging the gap between academia and
industry: transforming the universal variability language to pure::variants and back. MODEVAR@SPLC ‘22.
https://doi.org/10.1145/3503229.3547056

* José A. Galindo and David Benavides. 2020. A Python framework for the automated analysis of feature models: A first step to integrate
community efforts. MODEVAR@SPLC ‘20. https://doi.org/10.1145/3382026.3425773Josée A. Galindo, Jose-Miguel Horcas, Alexander
Felferning, David Fernandez-Amoros, and David Benavides. 2023. FLAMA: A collaborative effort to build a new framework for the
automated analysis of feature models. SPLC’ 23 - Tool Track. https://doi.org/10.1145/3579028.3609008

* Jose M. Horcas, Jose A. Galindo, Mdnica Pinto, Lidia Fuentes, and David Benavides. 2022. FM fact label: a configurable and interactive
visualization of feature model characterizations. SPLC 22. https://doi.org/10.1145/3503229.3547025

* David Romero, José A. Galindo, Jose-Miguel Horcas, and David Benavides. 2021. A first prototype of a new repository for feature model
exchange and knowledge sharing. SPLC ‘21. https://doi.org/10.1145/3461002.3473949
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Tools? THE most used SPL/Variability Mgmt Tool?

* Microsoft Excel!

JXU

LINZ INSTITUTE
OF TECHNOLOGY

. ~
A9 - = Bookl - Microsoft Excel |£IJ—hJ
g Home Insert Page Layout Formulas Data Review View & @ o BE ER

= - v e | = _ = H ) H genset - X v
Calibri 1l AN == ¥ = General - = A [
J Ec | "id _‘d * Delete = j' "Z? }}
Paste B 7T U~ | i~ Md-A- =E== 4+ [@- -9y » | %), Conditional Format Cell | ., ~ Sort& Find &
- = - FE = 2 % 00 ormatting ~ as Table - Styles ~ | [od Format * | (27 Filter = Select -
Clipboard Font Alignment Mumber Styles Cells Editing
B4 - Fx ¥
A B C D E F G H | J K L M N (0] :
1 Option Choice
2 |A? X
3 B?
L]
5 ..
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7
8
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M 4 » ¥| Sheetl /Sheet? ~Sheets ~¥J [« Il
Ready | | [FE|E @ 100% (=) {) (%)
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» 1 he Williams car build workbook, with roughly
20,000 individual parts”

. . - : Try Google Cloud with
/. Slashdot stores > Al Popular Polls /. Software  Newsletter  Jobs Submit S 2 00Tt EvaditE.

De 5 Build Entertainment Technology Open Source ¢ ce YRO

i Posted by BeauHD on Wednesday March 20, 2024 @11:30PM from the Excelblame-game dept.

An anonymous reader quotes a report from Ars Technica:
Starting in early 2023, Williams team principal James Vowles and chief technical officer Pat Fry started reworking the F1team's systems for designing and building its car. It would be painful, but the pain would keep the team from falling even further
behind. As they started figuring out new processes and systems, they encountered what they considered a core issue: Microsoft Excel. The Williams car build workbook, with roughly 20 000 individual parts, was "a joke," Vowles recently told The
Race. "Impossible to navigate and impossible to update.” This colossal Excel file lacked information on how much each of those parts cost and the time it took to produce them, along with whether the parts were already on order. Prioritizing one car

section over another, fram manufacture through inspection, was impossible, Vowles suggested.

"When you start tracking now hundreds of thousands of components through your organization moving around, an Excel spreadsheet is useless,” Vowles told The Race. Because of the multiple states each part could be in - ordered, backordered,
inspected, returned — humans are often left to work out the details. "And once you start putting that level of complexity in, which is where modern Formula 1 is, the Excel spreadsheet falls over, and humans fall over. And that's exactly where we are.”
The consequences of this row/column chaos, and the resulting hiccups, were many. Williams missed early pre-season testing in 2019, Workers sometimes had to physically search the team’s factory for parts. The wrong parts got priority, other parts
came late, and some piled up. And yet transitioning to a modern tracking system was "viciously expensive,” Fry told The Race, and making up for the painful process required "humans pushing themselves to the absolute limits and breaking.”

The idea that a modern Formula 1 team, building some of the most fantastically advanced and efficient machines on Earth, would be using Excel to build those machines might strike you as odd. F1 cars cost an estimated $12-316 million each, with
resource cap of about $145 million. But none of this really matters, and it actually makes sense, if you've ever worked IT at nearly any decent-sized organization. Then again, it's not even uncommon in Formula 1. When Sebastian Anthony embedded
with the Renault team, he reported back for Ars in 2017 that Renault Sport Formula One's Excel design and build spreadsheet was 77,000 lines long — more than three times as large as the Williams setup that spurred an internal revolution in 2023.

Every F1team has its own software setup, Anthony wrote, but they have to integrate with a lot of other systems: Computational Fluid Dynamics (CFD) and wind tunnel results, rapid prototyping and manufacturing, and inventory. This leaves F1 teams
"susceptible to the plague of legacy software,” Anthony wrote, though he noted that Renault had moved on to a more dynamic cloud-based system that year. (Renault was also "a big Microsoft shop” in other areas, like email and file sharing, at the
time.) One year prior to Anthony's excavation, Adam Banks wrote for Ars about the benefits of adopting cloud-based tools for enterprise resource planning (ERP). You adopt a cloud-based business management software to go "Beyond Excel " "If
PowerPuoint is the universal language businesses use to talk to one another, their internal monologue is Excel,” Banks wrote. The issue is that all the systems and processes a business touches are complex and generate all kinds of data, but Excel
is totally cool with taking in all of it. Or at least 1.048 576 rows of it. Banks cited Tim Waorstall's 2013 contention that Excel could be "the most dangerous software on the planet.” Back then, international investment bankers were found manually
copying and pasting Excel between Excel sheets to do their work, and it raised alarm.

https://tech.slashdot.org/story/24/03/20/2142229/formula-1-chief-appalled-to-find-team-using-excel-to-manage-20000-car-parts
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Custom-developed ,,PL“ Tools

* Typical scenario:
o Company recognizes need to manage variability
o Company implements their own solution to manage variability

* However, there are many commercial and academic PL tools existing
° pure::variants (now part of PTC), FeaturelDE (Open Source FOSD IDE), ...

J z U LINZ INSTITUTE Rick Rabiser — rick.rabiser@jku.at SECPS: A Story of Variability and
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Recent Work: Remaining Industry Challenges?

Case Domain

Focus

Main Challenges

1 Automotive mechatronics
2 Sensors, measuring devices

3 HVAC, home applicances
4  Metallurgical plant solutions
5 Agritech

6 Rail transport, rolling stock

7 Industrial automation
8 Defense, aerospace
9 Automotive powertrain controllers

Broaden product portfolio
Variant management & product configuration

System of systems PLE

Systematic variability management
Multi systems PL

Enhance reuse rate

New generation of automation products
Increase modularisation and reuse

PL variant management

Standards, “docs as code”, CI/CD, test strategy, project-based org.
PL verification

Ecosystem, multiple domains, verification and validation effort for variants, portfolio vs.
engineering across distributed locations

Dependence on automation platform vendors, variability on multiple levels and in multiple
disciplines

Long-living systems, small production volumes, multiple product lines, maintenance, tools for
modeling and simulation

Documenting, scoping and evaluating PL architectures, var. modeling, standardising modules,
module maintenance, org. structures

Knowledge silos, integration and testing, HIL testing, perception of slow platform development,
modification of shared assets

Perception of PLE, design authority, asynchronous information, governance, reuse scope,
proactive reuse identification, frequent analysis

Consistent variant management across disciplines, variant management in V & V, evolution of PLs,
PL of PLs, efficient var. realisation, usability of var. management tools, collaboration with OEMs

M. Becker, R. Rabiser, G. Botterweck: Not Quite There Yet: Remaining Challenges in Systems and Software Product Line Engineering as Perceived by Industry Practitioners, SPLC 2024.

J XU o technotooy
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Come to my SE Talk

* Fr, 11:45, Audimax-1

* Not Quite There Yet:
Remaining Challenges in
Systems and Software PLE
as Perceived by Industry

* Orread the paper  [m]35% % [m]

J z U LINZ INSTITUTE Rick Rabiser — rick.rabiser@jku.at
OF TECHNOLOGY https://rickrabiser.qithub.io/rick/

SE Variability

(© 26.02.2025, 11:00
@ Audimax-1 (Building 30.95)

Vorsitzende der Sitzung

SE Variability

A Andreas Metzger

@ Prasentationsmaterialien

Es gibt derzeit keine Materialien.

EE Liste der Beitrige @ Tagesordnung

Fr. 28/02
= Drucken PDF Vollbildansicht Detailansicht Filter
1:00 Modeling Variability in Complex Software Systems Ferruccio Damiani et al.
Auvdimax-1, Building 30.85 11:00 - 11:22

Variability Modeling of Products, Processes, and Resources in Cyber-Physical Production Systems Engineering
Kristof Meixner et al.

Not Quite There Yet: Remaining Challenges in Systems and Software Product Line Engineering as Perceived by Industr...

Martin Becker et al.
12:00

Software Reconfiguration in Robotics Sven Peldszus et al. é—/)

Audimax-1 , Building 30.95 12:07 - 1229

SECPS: A Story of Variability and

Complexity
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Useful Material/Further Reading: Useful Links

Variability Modeling Body of Knowledge: https://github.com/SECPS/VMBoK
Universal Variability Language: https://universal-variability-language.github.io/
MODEVAR Initiative: https://modevar.github.io/

Open Source Feature-oriented SW Development IDE: https://featureide.qgithub.io/

Online Var Modeling and Configuration Tool: https://variability.dev/

Software Product Line Conference: https://splc.net/

Variability Modeling Conference: https://vamosconf.net/

Repository of Teaching Material: http://teaching.variability.io/

Repository of Case Studies: https://but4reuse.qgithub.io/espla_catalog/

J z U LINZ INSTITUTE Rick Rabiser — rick.rabiser@jku.at SECPS: A Story of Variability and
OF TECHNOLOGY  https://rickrabiser.qgithub.io/rick/ Complexity 21



mailto:rick.rabiser@jku.at
https://rickrabiser.github.io/rick/
https://github.com/SECPS/VMBoK
https://universal-variability-language.github.io/
https://modevar.github.io/
https://featureide.github.io/
https://variability.dev/
https://splc.net/
https://vamosconf.net/
http://teaching.variability.io/
https://but4reuse.github.io/espla_catalog/

Useful Material/Further Reading: Textbooks

* S. Apel, D. Batory, C. Kastner, and G. Saake, Feature-Oriented Software Development:
Concepts and Implementation: Springer, 2013.

* R. Capilla, J. Bosch, and K. Kang, Systems and Software Variability Management: Concepts,
Tools and Experiences: Springer, 2013.

P. Clements and L. Northrop, Software Product Lines: Practices and Patterns: SEI Series in
Software Engineering, Addison-Wesley, 2001.

J. Martinez, W. K. G. Assuncéo, T. Ziadi, M. Acher, S. Vergilio, S., Handbook of Re-Engineering
Software Intensive Systems into Software Product Lines. R. E. Lopez-Herrejon (Ed.). Springer
2023.

K. Pohl, G. Béckle, and F. van der Linden, Software Product Line Engineering: Foundations,
Principles, and Techniques: Springer, 2005.

F. van der Linden, K. Schmid, and E. Rommes, Software Product Lines in Action - The Best
Industrial Practice in Product Line Engineering: Springer Berlin Heidelberg, 2007.
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Useful Material/Further Reading: Papers (to start
with and find other material)

* M. Becker, R. Rabiser, G. Botterweck: Not Quite There Yet: Remaining Challenges in Systems and
Software Product Line Engineering as Perceived by Industry Practitioners, SPLC 2024.

* T. Berger, J.P. Steghdfer, T. Ziadi, J. Robin, J. Martinez, J.: The state of adoption and the challenges
of systematic variability management in industry. Empirical Software Engineering, 25, 1755-1797,
2020.

e K. Czarnecki, P. Grunbacher, R. Rabiser, K. Schmid, and A. Wasowski: Cool Features and Tough
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Variability Model(s) (Repositories)
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